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Welcome to TimeControl Project™

. TimeControl Project is a premium version of TimeControl
Online and TimeControl Industrial Online that gives a
remarkable new perspective on project planning

We have taken the flexibility and depth of tracking project
actuals that TimeControl is so well known for and applied it to
' the project planning process

7 TimeControl Project Is unigue In that it allows for multiple
project perspectives to co-exist
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Project Planning by Perspective

A small number of senior

Strategic decision makers who must
choose what projects to advance

A group of professional directors,
Operational project managers and team

leaders who direct the work

A large group of resources who

Tactical do the work and report progress
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Strategic, Operational and Tactical
Perspectives

Strategic Operational Tactical

Budget Resource Levelling Task assignment

Resource Capacity Milestone Task updates

management

Project Prioritization Team management

Assigning teams

Project.TimeControl.com



Strategic Level Perspective

Strategic Project
Management looks over
the long term for the
whole organization. The
perspective includes
corporate success,
budgeting, resource
capacity and portfolio
prioritization
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Budget Planner

G TimeControl - TimeControl X + = =] X
L C @ O 5 https://docs.timecontrol.net/Application/P dv=61fe2100-d957-4ea5-ba90-98f810208310 w (B8] a s G o =
~ L]
TimeControl poseph Garaner & M @
Q ! ’ Sample - Project Manager - Project running budget planner + Create Sheet View = Sheet Views == Filter More v
& View opened for editing by you — Close
AL Home nsert Page Layout Formulas Data Review View v Show items where..
() Search:
0 [] only my assignments
A 8 C D E F G H J K L ;
&l l Assignee:
1
== 2 January Feburary March April May June July Project:
3 Enter budget available per month:  $500,000.00| $500,000.00 $500,000.00| $500,000.00 $500,000.00| $500,000.00| $500,000.00
4
After
& s =
6 Calculated Total Budget: $ 6,569,190.00 C lated budget alk d $222,500.00 $187,000.00 $187,585.00 $199,000.00 $259,000.00 $237,000.00 $191,000.00
?E 7/ Calculated Total Actuals To Date: $ 3,042,550.00 Calculated g budg labl $277,500.00 $313,000.00 $312,415.00 $301,000.00 $241,000.00 $263,000.00 $309,000.00 Before
& Calculated Remaining: $ 3,526,600.00 b4
8
# 10 Project Name Budget Cost to Date g Budg Unallocated Budg January Feburary March April May June July Afvanced Rlter:
11 Al Reporting System 1 $ 585,180.00 $34,920.00 $ 550,260.00 $491,260.00 $4,000.00 | $5,000.00 $30,000.00 $5,000.00 $5,000.00 $5,000.00 $5,000.00 Q
a 12 Boat Show $ 348,885.00 $ 282,425.00 $ 66,460.00 $ 258,885.00 $15,000.00 | $10,000.00 $10,000.00 $15,000.00 $15,000.00 $15,000.00 $10,000.00
13 BrightWork Online Sample $ 632,835.00 $ 80,450.00 $ 552,385.00 $ 230,000.00 $25,000.00 $15,000.00 $15,000.00 $15,000.00 $92,835.00 $40,000.00 $100,000.00 Reset
B8 14 Call Center Release 1.0 $ 373,050.00 $104,760.00 $ 268,290.00 $500000)  $1,500.00 $3,000.00 | $5,000.00 | $5,000.00 $7,165.00|  $60,000.00 $0.00
15 Call Center Release 1.0 $226,035.00 $104,760.00 $121275.00 $166,035.00 $15,000.00 $15,000.00 $15,000.00 $15,000.00 $0.00 $0.00 $0.00
a 16 Commerical Construction $81,540.00 $105,810.00 -$24,270.00 $ 81,540.00 $0.00 $0.00 $0.00 | $0.00 $0.00 $0.00 $0.00
17 Data Migration Project $313,065.00 $143,810.00 $ 169,255.00 $ 208,065.00 $25,000.00 $10,000.00 $10,000.00 $10,000.00 $15,000.00 $20,000.00 $15,000.00
18 EPM System for Project Management Office $ 669,645.00 $174,600.00 S 455,045.00 $544,060.00 $50,000.00 $25,000.00 $15,585.00 $10,000.00 $10,000.00 $10,000.00 $5,000.00
19 HMS Project $473,715.00 $110,660.00 $ 363,055.00 $308,715.00 $30,000.00 | $30,000.00 $30,000.00 $25,000.00 $25,000.00 $15,000.00 $10,000.00
20 Internal charge codes $124,245.00 $9,733.00 $114,512.00 $ 54,245.00 $15,000.00 $10,000.00 $15,000.00 $20,000.00 $5,000.00 $5,000.00 $0.00
21 Project $ 415,215.00 $174,990.00 $ 240,225.00 $260,21500/  $10,000.00 $5,000.00  $10,000.00 $20,000.00  $30,000.00  $40,000.00|  $40,000.00
2 Polar Development $ 398,295.00 $318,512.00 $79,783.00 $ 388,295.00 $5,000.00 | 35,000.007 $0.00 | $0.00 SO.OOV $O.(X)A SO.OOV
3 Polar Exploration Project $ 583,965.00 $279,360.00 $ 304,605.00 $469,96500  $12,000.00| $24,00000  $12,000.00| $24,000.00  $24,000.00|  $12,000.00 $6,000.00
24 Request for Proposal for new ERP System $70,785.00 $174,960.00 -$104,175.00 $ 70,785.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
25 TimeControl Demo Project $367,200.00 $139,680.00 $ 227,520.00 $262,200.00 S0.00_ $15,000.00 $15,000.00 $30,000.00 $30,000.00 $15,000.00 $0.00
26 TimeControl Deployment Project $374,130.00 $419,040.00 -$44,510.00 $374,130.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
27 TimeControl in VersionOne $531,405.00 $384,120.00 $147,285.00 $ 491,405.00 $15,000.00 $15,000.00 $5,000.00 $5,000.00 $0.00 S0,00_ $0.00
28
29
30

Project.TimeControl.com



Remaining Budget

G TimeControl - TimeControl X + = a X
& C @ O E) https://docs.timecontrol.net/Application/Planning/Sheets.aspx?dv=d340f0d5-c5th-4ba8-9cd7-d902162695fd fx‘ (58] s = G ° =
o
T’meconfrO’ Joseph Gardner ; ‘ e
meControl Project > Sample - Project Manager - Project remaining budget report X = : -
=F
Q Search... & View openeroredng by ot close. + Create Sheet View & Sheet Views v = Filter More «
i ) Show items where
Home Insert Page Layout Formulas Data Review View v
/ﬁ‘ HOME i Search:
@ TIMESHEET > ,
[ only my assignments
A B C D E F G H ] K L M N Assignee:
&l REPORTS > 7 |
ll TimeControl
= T P Project:
ER TABLES > |2 Project Description Remaining Budget Budgeted Cost .
3 AR Al Reporting System 1 $ 550,260.00 $34,920.00 $ 585,180.00 Remalnlng BUdgets (tOp 15 I'OWS)
O (iNks 5 4 BOAT SHOW Boat Show $66,460.00| $282,425.00 $348,885.00 $100,000.00  $300,000.00  $500,000.00 $700,000.00 After
o u 5 BRIGHTWORKONLINE BrightWork Online Sample $ 632,835.00 $ 632,835.00 $(100,000.00) $200,000.00  $400,000.00  $600,000.00 -
6 CALLCENTER_1-0 Call Center Release 1.0 $268,290.00| $ 104,760.00 $ 373,050.00 AIReporting System 1
Y= TIMECONTROL PROJECT 7 CALLCENTER RELEASE 1-0 Call Center Release 1.0 $121,275.00| $104,760.00  $226,035.00 sot s Before
8 CONSTRUCTION Commerical Construction $(24,270.00) $105,810.00  $81,540.00 ELTRY R
/, TOOLS > 9 DATA Data Migration Project $169,255.00| $ 143,810.00 $ 313,065.00 BrightWork OnlineSample 0
5 Advanced Filter:
10 EPM-PMO EPM System for Project Ma $495,045.00 $ 174,600.00 $ 669,645.00 il R RIS a1 Q
11 HMS PROJECT HMS Project $ 363,055.00 $ 110,660.00 $ 473,715.00 )
i ADMINISTRATOR 2|12 INTERNAL Internal charge codes $114512.00] $9,733.00  $124,245.00 Call CenterRelease 1.0
= =
. 13 PMO Project $240,225.00 S 174,990.00 $415,215.00 G G Reset
B LEGACY 2 |14 POLAR Polar Development $79,783.00| $318,512.00 $ 398,295.00
15 POLAREXPLORER Polar Exploration Project $304,605.000 $279,360.00 $583,965.00 Data MigrationProject
a MAINTENANCE > 16 RFP Request for Proposal for ne $ (104,175.00) | S 174,960.00 $70,785.00| gpy System for Project Management Office
17 TCDEMO TimeControl Demo Project $227,520.00| $ 139,680.00 $ 367,200.00 )
18 TCDEPLOY TimeControl Deployment P $(44,910.00) $419,040.00  $ 374,130.00 HMSEroject
19 TC_V1 TimeControl in VersionOne $147,285.00 $384,120.00  $531,405.00 Internal charge codes
20 )
21 Project
22 | Polar Development
23
Polar ExplorationProject
24
25 | Request for Proposalfor new ERP System
20 TimeControl Demo Project
27
28 | I Remaining Budget [ Actual Cost
29
30
31
32
1
Sheet Data —+
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One line per project

G TimeControl - TimeControl X + = a X
&« C @ O B hitpsi//docs.timecontrol.net/Application/Planning/Gantt.aspx?dv=4bfag448-bd11-412d-8450-6e66d1e49323 g D s ® 0@ Q@ =
L4
TimeControl Joseph Gardner & B @
Tim ntrol Project > All Projects 3 = ; e
Q Search... & View operiad for editing by you — Glose + Create GANTT View 2 GANTT Views v (C} == Filter More v
Show items where...
/ﬁ\ HOME OWNER START DATE DURATION (H) 015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 2026 2027 < 3
earchn:
@ TIMESHEET > | ess  F Polar Development 2021-03-30 11872h POLAR GR
- [ only my assignments
«ss b Boat Show 2020-12-25 328h ' EV) BOAT SHOW Assignee:
[l REPORTS >
oo » TimeControl in VersionOne 2022-03-12 Oh | TV
TABLES > [ i Project:
=2 oo » Commerical Construction 2020-03-03 2784h - CONSTRUCTION BOATSHOW X CONSTRUCTION X
‘5) LINKS > » Other - Anything not part of the filter criteria 2016-08-27 11560h m POLAR X PROJECTCONTROL X
TCVi X
:JE TIMECONTROL PROJECT Afer
A TOOLS >
Before
& ADMINISTRATOR >
Advanced Filter:
B LEGACY > Q
B MAINTENANCE > Reset
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Operational Perspective

Operational personnel
are project managers,
resource managers and
look project by project,
team by team and are
focused on the mid-
term success of each
project.

Project.TimeControl.com



Project Barchart / Resource Load

@ TimeControl - TimeControl Prc. X + = X
&« C @ O 8B hitps//docs.timecontrol.net/Application/Planning/Gantt.aspx?st=0&mnu=176&dv=7d62fd96-0103-4b22-9168-7c9d83829¢ w D &« ® 0 O =
(4
T’ m eCOn tr Ol Diana Jacob (Joseph Gardner) -t ‘ 0
Q TimeControl Project Sample - Resource Manager - Most recently created project - Resource allocation view =+ Create GANTT View & GANTT Views v Q Q = Filter More v
Show items where...
/h\ OWNER START DATE  DURATION (H) MAR APR MAY )
3 24-01 02-08 09-15 16-22 23-29 30-05 06-12 13-19 20-26 27-03 04-10 11-17 18-24 25- Search:
o - ¥ General Conditions 2020-03-03 128h ' | _
B [] only my assignments
s | **° Receive notice to proceed and sign contract RE 2020-03-03 16h . RE) CONSTRUCTION.1.1 Assignee:
Tam®
oo Submit bond and insurance documents 2020-03-06 8h . CONSTRUCTION.1.2
-\7“’ Project:
soe Prepare and submit project schedule 2020-03-10 8h ' CONSTRUCTION.1.3
[l | ees Prepare and submit schedule of values Unassigned 2020-03-12 8h l CONSTRUCTION.1.4 After
- | vee Obtain building permits Unassigned 2020-03-06 24h . CONSTRUCTION.1.5 Before
o —
.o Submit preliminary shop drawings (a3 2020-03-12 72h - CP) CONSTRUCTION.1.6 R
#F Submit monthly requests for payment 1G 2020-03-06 oh | 1G) CONSTRUCTION.1.7 Advanced Filter:
= - Sample - Most recent project with 20+ ¢ Q
Other 3 Unassigned 2020-03-03 16h . Other 3
Other 4 Unassigned 2020-03-06 8h . Other 4 Reset
Other 5 Unassigned 2020-03-10 8h ' Other 5
Other 6 Unassigned 2020-03-12 72h
Other 7 Unassigned 2020-03-06 Oh | Other 7
~ Long Lead Procurement 2020.03-09 s52h - consmuctonz
NAME WORKLOAD / CAPACITY MAR APR MAY
3 24-01 02-08 09-15 16-22 23-29 30-05 06-12 13-19 20-26 27-03 04-10 11-17 18-24 25-
Electric Contractor = 16.38%
Eric Vincent ' T
=a
G.C. Labor Crew 10.52% @ ﬂ
Joe Gardner ' 0.52%
—
Plumbing Contractor 15% @ @ 60% 60%
Robert Eglington 0.34%
|
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Work Commitment

G TimeControl - TimeControl X + = X
o (%) @ O E) https://docs.timecontrol.net/Application/Planning/Boards.aspx?dv=e5a1a7f6-0cfb-40d6-96d3-7 1b6ad253009 {} ® B s & 0 o =

TimeconfrOI Diana Jacob (Joseph Gardner) - ‘ e

Sample - Resource Manager - Planning - Backlog -> Todo selection

neContro 0 i P i =< Fi
Q Search... & View opened ot edting by you— elose =+ Create Board View & Board Views v = Filter More v
o &ED Show items where...
@ HOME Search:
Backlog Todo
© TIMESHEET > )
22h 13h [J only my assignments
Assignee:
283 CREWS > 5
CONSTRUCTION.1.5 CONSTRUCTION.1.7 CONSTRUCTION.10.4 CONSTRUCTION.1.4 CONSTRUCTION.1
Project:
M. MATERIALS > Obtain building permits Submit monthly requests for payment Spread stone ballast on seamless roof Prepare and submit schedule of values Receive nofice to pr ojeck
Ll REPORTS > 3h 7h ()c ] 10n 6h 2h fAlter
Y= TIMECONTROL PROJECT CONSTRUCTION.11.1 CONSTRUCTION.11.2 CONSTRUCTION.1.6 Before
Install window wall aluminum and glass Install interior stud walls and drywall Submit preliminary shop drawings
/’ ToOoLsS 2 Advanced Filter:
1h 1h ‘ Sh @ Sample - Planning - Backlog -> Todo sele Q
Reset
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Tactical Perspective

The Tactical Perspective
are team leaders, scrum
masters and individuals
who are actually
accomplishing the
projects

Project.TimeControl.com



Team Leader / Scrum Master

G TimeControl - TimeControl X + = X
& C @ O ﬁ https://docs.timecontrol.net/Application/Planning/Boards.asp: d-a104-4338-a85b-8ea%b '{} ® @ a2 - e o =

TimeControl e S & O

1. Project Manager - Work assignment (via swimlanes)

Q Search... & View.openad for editing by you — Glose + Create board 2 Boards v = Filter More v
A 5
/ﬁ‘ HOME Backlog + Selected for development + Done + In Progress + Show items where...
Search:
oh oh oh Oh
© TIMESHEET >
N N [] only my assignments
BOAT SHOW.1.14 3 BOAT SHOW.1.11 H BOAT SHOW.1.1 3 BOAT SHOW.1.10 : Assiiice
[:l REPORTS 2 Complete registration and booth fees Review event lead retrieval options Determine primary on-site tradeshow Determine any additional booth set-up
submission contact requirements
ER TABLES > e e e e Project:
fter
G LINK > A
o = BOAT SHOW.1.17 § BOAT SHOW.1.12 : v
o Review booth layout specifications and Determine payment options
Y= TIMECONTROL PROJECT restriction Before

A TooLS > e e

Advanced Filter:

< No Filter > Q

a ADMINISTRATOR > BOAT SHOW.1.18 : BOAT SHOW.1.13

Determine any modifications to your Exhibitor services request form
E LEGACY N organizations Reset
@ Y, ﬂ N7 Warning: Only 500 records are being
MAINTENANCE S 'S 2 < > Shm. Please filter to find what you're
looking for.
v Abarzua, Terry o
Backlog + Selected for development + Done + In Progress +
oh oh oh Oh

v Abbott, Jonathan o

Backlog + Selected for development + Done + In Progress +
oh oh oh oh O

Project.TimeControl.com




Team Leader

@ TimeControl - TimeControl X |

TimeControl

Q Search... D tro oject Sample - Individual - My assignments - Work by priority
v Urgent
& o zent @D
Backlog Todo
@ TIMESHEET >
oh 13h
Ll REPORTS >
BRIGHTWORKONLINE.PROJECT IN...
?E TIMECONTROL PROJECT Project Kick-off
TOOLS > 216 ’ @

PMO.1.1.1

Determine Project Office scope

4h 000

v
=
]
=3
c
3

<
e
g
:

Backlog Todo
18h 3h
PMO.1.2.1.2 PO 13

Establish a management framework . .
Training Materials

8h @I - @"

< C @ O 8 https://docs.timecontrol.net/Application/Planning/Boards.aspx?dv=3b1acf66-8d84-445a-a3f6-e55f96722f7d

In Progress

9h

POLAR.12

Reference Docs

9h

In Progress

2h

POLAR.11

Technical Documentation

2h

+ Create Board View

Done

oh

©0

Done

oh

©0e

V@mae@® 06 0

Gail Robinson (Joseph Gardner) == [\ e

< Board Views v == Filter More v

Show items where...
Search:

[ only my assignments
Assignee:

Gail Robinson X

Project:
After
v
Before
v
Advanced Filter:
Sample - Charges assigned to me Q

Reset
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Individual work assignments

@ TimeControl - TimeControl X ) = a X

& C @ O E) https://docs.timecontrol.net/Application/Planning/Boards.aspx?dv=ecc57cf6-88e7-4d76-9c3b-82cb04f78f03 Q (58] s & G o

Timecon'rOI Gail Robinson (Joseph Gardner) == & e

Sample - Individual - My assignments - Flat work list

PMO.1.1.1

Determine Project Office scope

o 000

POLAR.13

Training Materials

o ©00

CALLCENTER_RELEASE_1-0.B-010...

Sample: Design Login Page

8h @

POLAR.11

Technical Documentation

2h (r) 7]

POLAR.12

Reference Docs

o Q0

Q Search... & View opened for editing by you — Close =+ Create Board View < Board Views == Filter More v
Show items where...
4 HOME S :
earch:
Todo In Progress Done
© TIMESHEET >
24h 1%h oh [ only my assignments
Assignee:
l:sl REPORTS > 2
BRIGHTWORKONLINE.PROJECT IN... PMO.1.2.1.2
?E TIMECONTROL PROJECT Project Kick-off Establish a management framework Etoject:
TOOLS oh (jc Y cr) 8h ® After

Before

Advanced Filter:
Sample - Charges assigned to me

Reset
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HMS clients include...

: ESL\7EC X
iNNoATE  EAIU
EXPERTISE REACHING OQUT

SMarch ADRITL @&

Consulting AssociatesIne. ~ AEDONCONSULTING INC ]
/\O AAAAAAAAAAAAAAAAAAAA
= CRIM s OPAL-RT ,A

sl TECHNOLOGIES CAE & E

< |
VOLVO () LOCKNEED MA u‘rln% <>SEFA
l‘ KOCH MCAP

INDUSTRIES INC = Quebec | ’ venture Reeb0k A
%zmg:m ] RN KEll‘I ST FloaTEC

SERVICES

US Properties anwronmental

| Sciences

ol Government of

Saskatchewa
_"’ JOHNSON & WALES "
= UniveRrsiTy

TmcmR@ America’s Career Universizy®
SUMY co immigration MINNESOTA

- o Cmmunautes LAND TRUST

é CATERPILLAR
% GROUP % SIEMENS b SCISYS
Better Building Solutions

MINNESOTA

D onutoon 5 SANDOZ Montreal %

a Novartis company
Progress Rail
A Caterpillar Company

y_‘ AEGION @ JOHN DEERE

Stronger. Safer. Infrastructure.

ELECTRC MOTIVE
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TimeControl works In many industries

Engineering/Construction
CANAM

Koch Business Solutions
Keppel Floatec

JRI Engineering (Chile)
Aegion

Foster Wheeler

BOSCH Security Systems
ESI Inc of Tennessee
Karridale (Australia)

Defense / Aerospace

Aero Info (a Boeing Company)
CAE Electronics (Australia)
General Dynamics (Australia)

Manufacturing

Volvo-Novabus

Esterline Advanced Sensors (UK)
Progress Rail

ASL Environmental Sciences

Technology

AMD

EXFO

Ricoh

Accedian

Ascendant (Bermuda)

Financial

Centre de Recherche Informatique de
Montreal

MCAP

Residential Mortgage

Value Recovery

Vancity

Health/Pharmaceutical
Zoetis

Conservation
Kawartha Conservation
Minnesota Land Trust
Conservation Ontario

Government

SFMTA (San Francisco Mass Transit)
Ville de Montreal

AEMO (Australia)

Alachua County

RBQ (Régie du Batiment du Québec)
City of Rocklin

Ross Valley Sanitary

Other

Kelly Services
Reebok-CCM
Progress Rail

Pontoon Solutions
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Thank you!
For more information:

Find out more about TimeControl Project: project.timecontrol.com

Find out more about TimeControl: www.timecontrol.com

j To reach HMS Software: info@hms.ca
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